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1 Overview

Metrohm IC Driver 1.0, ICP-MS MassHunter is a software driver for inte-
grating Metrohm IC instruments in Agilent's ICP-MS MassHunter Software
5.3 or higher.

Press [F1] anywhere in the driver to open the online help.

1.1 About the documentation

NOTE

Read through this documentation carefully before putting the product
into operation.

The documentation contains important information and warnings
which you must follow in order to ensure safe operation of the product.
For information on safety instructions of the Metrohm IC instrument,
refer to the corresponding manual.

This tutorial describes the Metrohm IC Driver, ICP-MS MassHunter. For
information on MassHunter or the Agilent ICP-MS, refer to the Mass-
Hunter Workstation User Guide or the ICP-MS MassHunter
Help.

Symbols and conventions

The following icons and formatting may appear in this documentation:

Cross-reference to figure legend

The first number refers to the figure number, the
second to the product part in the figure.

Instruction step

Carry out these steps in the sequence shown.

Method Designations for names of parameters, menu items,
tabs and dialog windows in the software.

File ▶ New Menu or menu item

Work area /
Properties

Menu paths in order to arrive at a particular position
in the software.

[Next] Button or key.
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2 Comprehensive information

2.1 Preconditions

The following preconditions must be fulfilled to ensure proper mode of
operation:

￭ MassHunter is installed according to the Agilent instructions. Refer to
the Agilent instructions for information concerning the minimum sys-
tem requirements.

￭ The Metrohm IC Driver 1.0, ICP-MS MassHunter is installed according
to the installation instructions (8.0102.8021EN Installation instructions
for Metrohm IC Driver 1.0, ICP-MS MassHunter).

NOTE

Refer to the MassHunter Help for further information on preconditions:
Learning ▶ User Manuals ▶ Software ▶ MassHunter 5.x Instal-
lation Guide.

2.2 Terminology

For the understanding of this tutorial, it is important to define the terms
unit, module and instrument.

Unit A unit is a functional part of a module. Units are for example high-pres-
sure pumps, injectors or degassers.

Module A module is an instrument with its own housing. A module consists of
several units. Modules are for example 930/940 ICs, 858 Professional Sam-
ple Processors or 942 Extension Modules.

Instrument An instrument consists of several modules. An instrument contains all
modules that are required for the analysis. An instrument is for example
the combination of a 930 Compact IC Flex and an 858 Professional Sam-
ple Processor.
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3 Instrument configuration

In the configuration, all comprehensive instrument settings (e.g., device
name, serial number) are defined.

An instrument may maximally include the following modules:

￭ 1 IC instrument (930 Compact IC Flex or 940 Professional IC Vario)
￭ 1 autosampler (889 IC Sample Center or 858 Professional Sample Pro-

cessor or 919 IC Autosampler plus)
￭ 1 Remote Box MSB: The Remote Box is mandatory in instruments with

an Agilent ICP-MS. Together with the IC equipment, connection Agi-
lent ICP-MS, the Remote Box enables remote control between the IC
instrument and the Agilent ICP-MS. The Remote Box must be
connected to MSB 1 of the IC instrument.

￭ 1 800 Dosino per IC instrument, 3 800 Dosinos per 858 Professional
Sample Processor or 919 IC Autosampler plus

￭ 3 942 Extension Modules Vario per 940 Professional IC Vario

Additionally, the IC equipment, connection Agilent ICP-MS (6.05330.400)
is mandatory in instruments with an Agilent ICP-MS. Together with the
Remote Box MSB, the IC equipment, connection Agilent ICP-MS enables
remote control between the IC instrument and the Agilent ICP-MS.

NOTE

Only the Dosino that is connected to the IC can be used for Dosino
regeneration or a Dose-in gradient. Dosinos that are connected to the
858 Professional Sample Processor or 919 IC Autosampler plus can be
used for liquid handling.

Always connect the Remote Box to MSB 1.

Configuration

 

1 Ensure that there is no leak in the Metrohm instruments.

Switch on the Metrohm instruments.

 

2 Open the application Instrument Configuration (Windows start
menu ▶ Metrohm ▶ Instrument Configuration).

 

3 Click on [Select Instruments...].

The Instrument Selection dialog opens.
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4 In the Instrument Selection dialog, click on [Scan] to confirm that
the driver should discover Metrohm instruments.

All connected modules are recognized automatically.

 

5 To select the discovered modules, click on [Select All].

Confirm your selection with [OK].

The Metrohm IC Configuration dialog shows the configured mod-
ules.

 

6 Double-click on a module to set the configuration parameters (see
"Configuration parameters", page 4).

 

7 Click on [Save] in the Metrohm IC Configuration dialog.

 

8 After saving the configuration, you can create a configuration report.

Therefore, click on the Print icon . Select a location to store the
configuration report as PDF file (see chapter 14.1, page 80).

NOTE

The stirrer of the 858 Professional Sample Processor is deactivated by
default. If you want to use the stirrer, then activate the stirrer in manual
configuration of the 858 Professional Sample Processor (see chapter
7.3.1, page 43).

Configuration parameters

￭ 930 Compact IC Flex / 940 Professional IC Vario / 942 Extension Mod-
ule Vario

￭ 858 Professional Sample Processor
￭ 889 IC Sample Center
￭ 919 IC Autosampler plus
￭ Dosing device
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4 Physical connection between IC and Agilent
ICP-MS

4.1 Remote connection IC instrument – Agilent ICP-MS

NOTE

For further information on remote signal settings, refer to the Mass-
Hunter Workstation User Guide or the ICP-MS MassHunter
Help. To open the help, press [F1] in the window you want to learn
more about.

Signals between the IC instrument and the Agilent ICP-MS are transferred
via remote signals. Therefore, the Remote Box and the IC equipment,
connection Agilent ICP-MS are required.

Figure 1 Connection Box, remote control ICP-MS

1 Connector Remote Box 2 Connector Leak Sensor

3 Connector ICP-MS

Install the Remote Box MSB and the IC equipment, connec-
tion Agilent ICP-MS

WARNING

Electric shock caused by live parts

Never open the housing of the Connection Box, remote control ICP-MS.
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WARNING

Damage due to unauthorized cables

To prevent damage on the Connection Box, remote control ICP-MS, the
Metrohm IC instrument or Agilent ICP-MS, only the following cables
may be used:

￭ Remote cable, IC - Agilent ICP-MS (6.2141.410)
￭ Connection cable, Remote Box MSB (6.2141.420)
￭ Connection cable, leak sensor (6.2141.430)

WARNING

Damage due to relocation

To prevent damage on the Connection Box, remote control ICP-MS, the
Metrohm IC instrument or Agilent ICP-MS, all cables must be unplug-
ged before relocating any of the connected devices.

Accessories:

￭ Remote Box MSB (6.2148.010)
￭ IC equipment, connection Agilent ICP-MS (6.05330.400)

– Connection Box, remote control ICP-MS (6.2149.310)
– Remote cable, IC - Agilent ICP-MS (6.2141.410)
– Connection cable, Remote Box MSB (6.2141.420)
– Connection cable, leak sensor (6.2141.430)

Alternatively to ordering the IC equipment, the required parts can be
ordered individually.

A B C D
6.2141.420 6.2141.410

6.2141.430

Leak sensor connection cable

Figure 2 Remote connection

A IC instrument B Remote Box MSB

C Connection Box, remote control ICP-
MS

D Agilent ICP-MS

 

1 Remote Box MSB

Connect the Remote Box MSB to the connector MSB 1 of the IC
instrument.
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2 Connection cable, Remote Box MSB (6.2141.420)

Connect the Remote Box MSB and the connector Remote Box of
the connection box.

 

3 Leak sensor connection cable

On the backside of the IC instrument, disconnect the leak sensor
connection cable from the connector Leak Sensor.

Connect the leak sensor connection cable to the connector Leak
Sensor of the connection box.

 

4 Connection cable, leak sensor (6.2141.430)

Connect the connector Leak Sensor of the connection box and the
connector Leak Sensor of the IC instrument.

 

5 Remote cable, IC - Agilent ICP-MS (6.2141.410)

Connect the connector ICP-MS of the connection box and the
remote connector of the Agilent ICP-MS.

With the described installation, the Remote Interface is connected to the
leak sensor of the IC instrument. If the plasma is switched off, the leak
sensor receives a signal to stop the IC instrument. If a message appears
stating that a leak was detected, either a leak occurred on the IC instru-
ment or the leak sensor received a stop signal from the Agilent ICP-MS.
The message is logged in the Diagnostics file (see "Log files", page 84).

4.2 Spray chamber connections

Spray chamber inlet

For the ignition sequence and the tuning, connect the spray chamber inlet
to the tuning solution.

For data acquisition, connect the spray chamber inlet to the eluent outlet
of the IC instrument.

Spray chamber outlet

Metrohm recommends to transfer the waste from the spray chamber out-
let with the peristaltic pump of the IC instrument. The peristaltic pump of
the IC instrument must always be running while running the Agilent ICP-
MS. You can use the waste from the spray chamber as regeneration solu-
tion for the MSM (STREAM).

In case of a software crash, the Agilent ICP-MS and the IC instrument do
not stop. If the Agilent ICP-MS runs out of gas, it stops. Because the soft-
ware is no longer running, the IC instrument does not receive a stop signal
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from the Agilent ICP-MS and continues to run. As consequence, the elu-
ent accumulates in the spray chamber if you transfer the waste from the
spray chamber outlet with the peristaltic pump of the Agilent ICP-MS. The
disposal of the waste is not guaranteed. This risk only occurs if the soft-
ware or the computer crashed. Else, if one of the instruments stops during
a running batch, the other instrument stops as well.
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5 ICP-MS Instrument Control – First start-up

In the program part ICP-MS Instrument Control, the user can create
and manage batches and all components belonging to a batch (e.g.,
instrument method, acquisition parameters, sample list).

Set-up Metrohm modules

ICP-MS Instrument Control is opened for the first time after installing the
Metrohm IC Driver 1.0, ICP-MS MassHunter.

 

1 Start ICP-MS Instrument Control.

The dialog Application Key opens.

 

2 Enter the following details:

￭ Application Key: MetrohmIC
￭ Application Label: MetrohmIC
￭ Device Type: Other

Click on [Register] to open ICP-MS Instrument Control.

The ICP-MS MassHunter Workstation dialog opens.

NOTE

If any other Device Type than Other is selected, ICP-MS Instru-
ment Control cannot function properly. The ICP-MS Instrument
Control needs to be reset:

1. Close ICP-MS Instrument Control.
2. Open the folder:

C:\Program Files\Agilent\Spectroscopy\PluginFramework
3. Delete the file MetrohmIC.xml
4. Start ICP-MS Instrument Control and enter the correct details.

 

3 Select the program part Instrument Control.

ICP-MS Instrument Control opens (see chapter 5, page 9). The
Dashboard is shown.

 

4 On the dashboard, right-click on Mainframe and select External
Device.

The External Device Connection dialog appears.
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5 On the tab MetrohmIC enable the check box Connect.

Confirm with [OK].

 

6 Right-click on Sample Introduction and select Settings....

The Settings dialog appears.

 

7 In the Sample Introduction selection list, select Other.

Close the dialog with [Close].

The Metrohm modules are shown on the Dashboard.

The Instrument method opens. In the Instrument method win-
dow, you can create a method with the configured Metrohm mod-
ules (see chapter 6, page 12).

Toolbar

Task Navigator

Instrument
status

Metrohm modules

Figure 3 ICP-MS Instrument Control – Dashboard overview
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Instrument
Method tab

Manual Control/Status tab

Parameter tab
per module

Set floating window Help

Figure 4 Metrohm IC Driver, ICP-MS MassHunter – Overview
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6 Method

A method is an instruction for processing a sample. A method consists of
start parameters (see chapter 7.1.1, page 16) and time programs (see
chapter 7.1.2, page 17).

6.1 Instrument method

ICP-MS Instrument Control ▶ Hardware ▶ Dashboard ▶ Instrument Method

Create an instrument method

 

1 Navigate to Task Navigator ▶ Hardware ▶ Dashboard. Right-
click on MetrohmIC and select Properties.... Confirm the appear-
ing dialog with [OK].

A new method is opened. The status of the method is New
Method.

Alternatively, create a method with the New Method icon .

The start parameters and time program of each Metrohm module are
visible in individual tabs.

The start parameters are set to the default values.

?

Parameters

Method status

Method name

Module name

Unit start parameters

Module time program

Figure 5 ICP-MS Instrument Control – Method
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2 If necessary, adapt the start parameters (see chapter 7.1.1, page
16).

Write the time program for each module (see chapter 7.1.2, page
17).

 

3 Save the method with the Save icon . Select a location to store
the method in the file format *.xml.

After saving the method, the status of the method is changed to
Opened Method.

You can create a method report. Therefore, click on the Print icon

. Select a location to store the method report in the file format
*.pdf (see chapter 14.2, page 80).

 

4 Click on Float External Device Control to open the method in a
separate floating window. Otherwise, the method is no longer visible
under Dashboard ▶ Instrument control once you sent the
method to the instrument.

NOTE

If you open the method in a floating window, windows that open
afterwards are positioned behind the floating window. This can
result in a deadlock, in which a window requests an action. All
other windows are inactive until this action has been performed.
However, the window that requires an action is inaccessible
because it is located behind the floating window. All windows
automatically open in the middle of the primary screen. To avoid
the described problem, Metrohm recommends to open the float-
ing window on a second screen or in the right quarter of the pri-
mary screen (see chapter 7.1, page 15).

To operate the IC instrument with specific instrument parameters after the
last sample, create a specific end method. Therefore, create an instrument
method with the desired start parameters. Run the method as sample in
the last line of the sample list (see chapter 11, page 74).
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6.2 Method resolve

If you load a method, then the Metrohm IC Driver, ICP-MS MassHunter
checks whether the configured hardware corresponds to the instrument
the method was written with.

It is possible to load a method that was written on an instrument with a
different configuration. In this case, the Metrohm IC Driver, ICP-MS Mass-
Hunter resolves the differences between the instruments in the following
way:

￭ If the configured instrument contains different modules than the
instrument from the loaded method, all modules and time program
commands are removed from the method.

￭ If the configured instrument contains fewer modules than the instru-
ment from the loaded method, all modules and time program com-
mands are removed from the method.

￭ If the configured instrument contains more modules than the instru-
ment from the loaded method, then the additional modules are added
to the method. The start parameters are set to their default values.
Adapt the start parameters if necessary. The time program of the addi-
tional modules is empty.

￭ If the configured instrument contains fewer units than the instrument
from the loaded method, then the start parameters of the missing units
are removed. A warning occurs in the time program if a time program
command uses a non existing unit. The user has to resolve this differ-
ence manually by deleting or adapting the affected time program com-
mand.

￭ If the configured instrument contains more units than the instrument
from the loaded method, then the default start parameters of the addi-
tional units are added. Adapt the start parameters if necessary.

If a method resolve is necessary, a message appears. If you open a method
that has been resolved previously, the method resolve message appears
again because the original configuration is still stored in the background.
Despite the message, another method resolve is not necessary.
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7 Instrument parameters

NOTE

In this tutorial, instrument parameters for all modules and units are
described. It depends on your instrument configuration which parame-
ters you can set. In the Metrohm IC Driver, ICP-MS MassHunter only the
parameters available for your instrument are visible.

7.1 General description

NOTE

If you open the method in a floating window, windows that open after-
wards are positioned behind the floating window. This can result in a
deadlock, in which a window requests an action. All other windows are
inactive until this action has been performed. However, the window
that requires an action is inaccessible because it is located behind the
floating window. All windows automatically open in the middle of the
primary screen. To avoid the described problem, Metrohm recommends
to open the floating window on a second screen or in the right quarter
of the primary screen.

2

M1

Last step
3.2 min

MetrohmIC

Instrument Method

State of degasser, MCS, MSM,
peristaltic pump

Manual Control / Status

??

Figure 6 Floating window right quarter
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7.1.1 Start parameters
ICP-MS Instrument Control ▶ Hardware ▶ Dashboard ▶ Instrument Method

Start parameters are sent to the units when you start the method.

To open the method section, right-click on MetrohmIC and select Prop-
erties.... Open the Instrument Method tab.

Click on a unit to set its start parameters. If the instrument contains 2
units of the same type (e.g., 2 high-pressure pumps), then the same menu
appears for both units (see chapter 7.1.4, page 21). The start parameters
of both units can be set independently.

Figure 7 Instrument method tab

Parameters

￭ 930 Compact IC Flex / 940 Professional IC Vario / 942 Extension Mod-
ule Vario

￭ 858 Professional Sample Processor
￭ 889 IC Sample Center
￭ 919 IC Autosampler plus



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 7 Instrument parameters

Metrohm IC Driver 1.0, ICP-MS MassHunter ￭￭￭￭￭￭￭￭ 17

7.1.2 Time program
ICP-MS Instrument Control ▶ Hardware ▶ Dashboard ▶ Instrument Method

Write a time program to set the chronological order of actions during your
measurement.

To write a time program, right-click on MetrohmIC and select Proper-
ties.... Open the Instrument Method tab. The last line of a modules
method editor contains the time program.

If several modules are configured (e.g., 940 Professional IC and 858 Pro-
fessional Sample Processor), then each module has its own time program.
Several modules can be synchronized with events (see chapter 7.1.2.1,
page 17).

To write a time program command, click on [Add]. Select a command in
the drop-down list and define the command in the appearing dialog.

Time program
Parallel     Function                             Parameter

Parameter selection

Add

Figure 8 Adding time program commands

Parameters

￭ 930 Compact IC Flex / 940 Professional IC Vario / 942 Extension Mod-
ule Vario

￭ 858 Professional Sample Processor
￭ 889 IC Sample Center
￭ 919 IC Autosampler plus
￭ Dosing device

7.1.2.1 Device-independent commands

ICP-MS Instrument Control ▶ Hardware ▶ Dashboard ▶ Instrument Method

Device-independent com-

mands

Parallel To save time, run 2 commands in parallel. Check the checkbox Parallel. While a
command is being executed, the time program already continues with the next
line. This option is possible for all time program commands of the dosing device
and for the time program command Move.
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Wait Holds the program schedule.

Events ▶ Each module has its own time program. These time programs run in parallel but
independently of each other. Synchronize time programs with the time program
commands Event Set, Event Wait and Event Reset.

Event Set An Event Set triggers actions in other time program commands. An Event Set
indicates the moment when another time program has to execute its com-
mands.

As soon as the time program reaches the line with the Event Set, other time
programs can see the Event Set.

Event Wait An Event Wait is always looking for Event Sets with the same name. If the
Event Wait of a time program detects a corresponding Event Sets, then the
time program executes the commands that follow after the Event Wait.

Event Reset An Event Reset removes the corresponding Event Set. If you set an Event
Reset, then the Event Wait keeps on looking for the corresponding Event Set
and does not execute subsequent time program commands.

Example of a time program with device-independent com-
mands and events

This example describes the synchronization of 2 time programs with
events.

Both time programs start in parallel.

First, the sample processor transports the sample to the injector. Then the
IC injects, while the sample processor rinses the needle. Therefore, the
time program of the IC must wait until the sample processor has transpor-
ted the sample to the injector.

Time program – 930 Compact IC Flex

Table 1 Time program – 930 Compact IC Flex

 Function Parameter

1 Event Wait Event Wait: Name = Loop Filled

2 Switch injector Injector: 1, Position = Inject

 

1 Event Wait: Name=Loop Filled

The time program of the IC is looking for an event set called Loop
Filled.

When the event set Loop Filled is executed in the time program of
the sample processor, the IC starts executing the command in line 2.
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2 Switch injector

The IC switches the injector to the position Inject.

Time program – 858 Professional Sample Processor

Table 2 Time program – 858 Professional Sample Processor

 Function Parameter

1 Move Move: Position type = VialFromSequence, Lift
Position = Work

2 Set peristaltic Pump: Rate = 3, On

3 Wait Wait: Wait time = 3 min

4 Set peristaltic Pump: Rate = 1, Off

5 Event Set Event Set: Name = Loop Filled

6 Move Move: Position type = ExternalPosition, External
Position = Rinse

7 Set peristaltic Pump: Rate = 3, On

8 Wait Wait: Wait time = 3 min

9 Set peristaltic Pump: Rate = 1, Off

 

1 Move

The sample processor moves to a position on the rack to take a sam-
ple.

 

2 Set peristaltic

The peristaltic pump of the sample processor starts on rate 3.

 

3 Wait

The time program of the sample processor waits for 3 minutes before
it continues with the next line. During the waiting time, the peristaltic
pump transports the sample to the injector.

 

4 Set peristaltic

The peristaltic pump of the sample processor stops.

 

5 Event Set: Name=Loop Filled

This event set matches the event wait of the IC because both events
have the same name.
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As soon as the time program of the IC reaches the line with the
event wait command, the time program of the IC starts looking for
the corresponding event set.

Now, as the time program of the sample processor reached the event
set, the IC starts executing the commands that follow the event wait
command.

 

6 Move

The sample processor moves to a position on the Liquid Handling
Station.

 

7 Set peristaltic

The peristaltic pump of the sample processor starts on rate 3.

 

8 Wait

The time program of the sample processor waits for 3 minutes before
it continues with the next line. During the waiting time, the needle is
rinsed in the Liquid Handling Station.

 

9 Set peristaltic

The peristaltic pump of the sample processor stops.

7.1.3 Manual control/Status
ICP-MS Instrument Control ▶ Hardware ▶ Dashboard ▶ Manual Control/Status

The units of a module are shown in different status panels.

To access the status panels, right-click on MetrohmIC and select Proper-
ties.... Open the Manual Control/Status tab.

The status panels display the live parameters of the configured units and
enable the user to operate the individual units manually.

NOTE

To receive detailed information about a unit, hover the cursor over the
corresponding unit (e.g. Column).
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?

State of degasser, MCS, MSM, 
peristaltic pump

State of thermostat State of injector, high-pressure pump

Figure 9 Manual Control / Status tab

Open the manual control of a unit by right-clicking on the respective icon
in the status panel.

To confirm changes in manual control and leave the dialog, click on [OK].
To confirm changes and keep the dialog open, click on [Apply]. To close
the dialog, click on the close button [X]. If you didn't apply the changes
before closing the dialog, the changes are discarded.

NOTE

If the instrument goes offline, the status panels do not show the actual
instrument status anymore. The status panels display the instrument
status at the time the instrument was last online. The hardware does
not switch off automatically if the instrument goes offline. To ensure
that the hardware is off, switch off the hardware with the power-off
button.

With the stop button  you can stop the IC instrument immediately. If
you press the stop button during a determination, the determination is
aborted immediately.

Parameters

￭ 930 Compact IC Flex / 940 Professional IC Vario / 942 Extension Mod-
ule Vario

￭ 858 Professional Sample Processor
￭ 889 IC Sample Center
￭ 919 IC Autosampler plus
￭ Dosing device

7.1.4 Numbering of the units
If you set start parameters and time program commands, you have to
select the index of the respective unit.

The numbering of each unit depends on its position in the daisy chain.
The daisy chain defines how multiple modules are wired together in
sequence.
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￭ For 930/940 ICs this means: The upper unit always gets the number 1,
the lower unit number 2 (e.g., for pumps and injectors).

￭ For 942 Extension Modules this means: Only 1 extension module can
be connected directly to the IC instrument. The second extension mod-
ule has to be connected to the first extension module. The third exten-
sion module has to be connected to the second extension module. The
numbering of the units begins with the IC instrument and continues
with the extension modules according to their position in the daisy
chain.

NOTE

The numbering is fixed and cannot be changed manually.

In the status panels, the numbers of the units are not shown. Distinguish
identical units by their position in the status panel.

Table 3 Numbering of the units in the status panel

1 3

2 4

Example dosing devices:

Numbering of the dosing devices in the status panel. The instrument con-
tains 3 dosing devices.

 5
mL

50
mL

10
mL1

2

3

Figure 10 Numbering of the dosing devices
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7.2 930 Compact IC Flex / 940 Professional IC Vario /
942 Extension Module Vario

The 930 Compact IC Flex and 940 Professional IC Vario are ion chromato-
graphs. The 930 Compact IC Flex and 940 Professional IC Vario are avail-
able in various product versions with different units.

The 942 Extension Modules Vario are used to expand 940 Professional ICs
Vario with additional functions. The Metrohm IC Driver, ICP-MS Mass-
Hunter supports 3 product versions of the 942 Extension Module Vario:

￭ 942 Extension Module Vario HPG: Expands your instrument to a gradi-
ent instrument.

￭ 942 Extension Module Vario ONE/Deg: Expands your instrument with
an additional channel.

￭ 942 Extension Module Vario SeS/PP: Expands your instrument with
sequential suppression.

7.2.1 Configuration

930 IC/940 IC/942 Exten-

sion Module

Communication The following parameters are entered automatically:

￭ Device name
￭ Type ID
￭ Serial number

Options ▶

MSB The connected MSB devices are recognized automatically. The following MSB
devices are available:

￭ 800 Dosino
Always connect the Dosino to MSB 2.

￭ Remote Box
The Remote Box is mandatory in instruments with an Agilent ICP-MS!
The Remote Box coordinates control signals between the IC and the Agilent
ICP-MS. The IC and the Agilent ICP-MS are able to send and receive signals
via remote lines.
Always connect the Remote Box to MSB 1.
Configure the Remote Box for the 930/940 IC. Do not select the Remote Box
as MSB device for the 858 Professional Sample Processor or 919 IC Autosam-
pler plus.

Click on [Configure] to set further parameters (see chapter 7.6.1, page 63).

Extension mod-

ule
Extension modules are only available for 940 ICs. Extension modules are detec-
ted automatically.
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Gradient Pumps Gradient pumps are only available for 940 ICs.

A high-pressure gradient can only be configured for 940 Professional ICs
Vario and for 942 Extensions Modules Vario that are connected to a 940
Professional IC Vario. At least 2 high-pressure pumps are necessary to configure
a high-pressure gradient.

Define the following parameters:

￭ Number of Pumps
Define how many pumps the high-pressure gradient pump consists of.

￭ Pump A–D
Assign the high-pressure pumps to the gradient pump.
A high-pressure pump can be used either for a high-pressure gradient or for
a Dose-in gradient or as a normal high-pressure pump. A high-pressure
pump cannot be configured for several functions.

Dose-in gradient For ICs with a high-pressure pump and a Dosino, it is possible to configure a
gradient pump for a Dose-in gradient.

Define the following parameters:

￭ Pumps
Select a high-pressure pump that you want to use for the Dose-in gradient
pump.
A high-pressure pump can be used either for a high-pressure gradient or for
a Dose-in gradient or as a normal high-pressure pump. A high-pressure
pump cannot be configured for several functions.

￭ Dosino
Assign a Dosino to the selected high-pressure pump.

Regeneration For ICs with an MSM and a Dosino, it is possible to configure Dosino regenera-
tion for the MSM. The regeneration solution for the MSM regeneration is trans-
ported and dosed by a dosing device.

Define the following parameters:

￭ MSM
Select an MSM to be regenerated with Dosino regeneration.

￭ Dosino
Assign a Dosino to the selected MSM.
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NOTE

A Dosino can be used either for a Dose-in gradient or for Dosino regen-
eration or as a normal Dosino. A Dosino cannot be configured for sev-
eral functions.

You can use only 1 Dosino with the IC instrument. Connect the Dosino
to MSB 2 of the IC. Connect the Remote Box to MSB 1 of the IC. You
cannot connect the Dosino to the MSB socket of the Remote Box. Oth-
erwise, the Remote Box is not recognized anymore.

If you want to use a Dosino for Dosino regeneration or a Dose-in gradi-
ent, then configure it for a 930/940 IC. It is not possible to use Dosinos
at the 858 Professional Sample Processor for Dosino regeneration or
Dose-in gradients.

NOTE

A high-pressure pump can be used either for a high-pressure gradient
or for a Dose-in gradient or as a normal high-pressure pump. A high-
pressure pump cannot be configured for several functions.

7.2.2 Start parameters

7.2.2.1 High-pressure pump

Pump 1

On The high-pressure pump is switched on when you start the method.

Flow Flow of the high-pressure pump when you start the method.

The maximum permitted flow depends on the spray chamber. Refer to Agilent
instructions for your instrument.

Start-up time Define a start-up time for reaching the defined flow rate.

PMin Minimum permitted pressure in the instrument when you start the method.

PMax Maximum permitted pressure in the instrument when you start the method.

If the IC contains a column, the maximum pressure of the column is used as
default value for PMax.
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NOTE

If the pressure is below PMin or above PMax, an error is generated and
logged in the Diagnostics file (see "Log files", page 84). The instru-
ment is switched off.

NOTE

Besides the PMax that is defined in the start parameters, there is a
PMax written on the column chip. If these values differ, an error is gen-
erated and logged in the Diagnostics file (see "Log files", page 84) as
soon as the lower of both values is exceeded.

Each column holder is assigned to a high-pressure pump.

￭ Pump 1 – Column holder A
￭ Pump 2 – Column holder B
￭ Pump 3 – Column holder C



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 7 Instrument parameters

Metrohm IC Driver 1.0, ICP-MS MassHunter ￭￭￭￭￭￭￭￭ 27

7.2.2.2 Injector

Injector 1

Position Position of the injector when the run starts.

￭ Inject
Switches the valve to Inject.

￭ Fill
Switches the valve to Fill.

￭ Maintain Current
The valve maintains its current position.

7.2.2.3 MSM

MSM 1

Automatic stepping

to next position dur-

ing equilibration

If you enable this option, then automatic stepping of the rotor to the next posi-
tion is initiated within the equilibrate mode and between injections. The time
interval defined in the parameter interval is used.

Interval Time interval between 2 sequential automatic rotor stepping operations.

Dosino regenera-

tion ▶
If Dosino regeneration is configured, then it takes place automatically after each
step of the rotor.

This parameter is only shown if Dosino regeneration is configured.

Dosing device The dosing device is defined in the configuration of the Dosino regeneration
(see chapter 7.2.1, page 23).

Solution ▶ These parameters are only shown if Dosino regeneration is configured.

Dosing Port Port for dosing the regeneration solution.

Volume Volume of the regeneration solution.

Time Duration of the regeneration.

The Dosino regeneration time must not be longer than the acquisition time.

Dosing rate Dosing rate at which the MSM is regenerated. The dosing rate is automatically
calculated from the Volume and Time.

This dosing rate is only applied to sequences and single sample analysis. If you
send the current method to the instrument to equilibrate the instrument, then
the default dosing rate of 1.0 mL/min is applied for the first MSM step. For all
following MSM steps, the dosing rate from the method is applied.

Fill Port Port for filling the regeneration solution.
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7.2.2.4 MCS

MCS 1

On The MCS is switched on when you start the method.

7.2.2.5 Degasser

Degasser 1

On The degasser is switched on when you start the method.

7.2.2.6 Peristaltic pump

Peristaltic pump 1

On The peristaltic pump is switched on when you start the method.

Rate Rate of the peristaltic pump when you start the method.

7.2.2.7 Thermostat

Thermostat

On The thermostat is switched on when you start the method.

Temperature Temperature that is set for the thermostat when you start the method.

Wait for Stable

Temperature A run does not start before the set temperature has been reached and is stable.

7.2.2.8 High-pressure gradient

Gradient Pumps

On The high-pressure gradient pump is switched on when you start the method.

Flow Flow of the high-pressure gradient pump when you start the method.

The maximum permitted flow depends on the spray chamber. Refer to Agilent
instructions for your instrument.

Start-up time Define a start-up time for reaching the defined flow rate.

PMin Minimum permitted pressure in the instrument when you start the method.

The high-pressure gradient pump consists of several individual high-pressure
pumps. If the pressure of 1 individual high-pressure pump falls below PMin, an
error is generated and logged in the Diagnostics file (see "Log files", page
84).
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PMax Maximum permitted pressure in the instrument when you start the method.

The high-pressure gradient pump consists of several individual high-pressure
pumps. If the pressure of 1 individual high-pressure pump exceeds PMax, an
error is generated and logged in the Diagnostics file (see "Log files", page
84).

Eluent A–D Define the proportion in the mixing ratio for each eluent. Ensure that the total
of all eluent proportions is 100%.

Gradient… Click on [Gradient...] to define the gradient profile. Execute the gradient profile
with the time program command Start Gradient. For each step in the gradient
profile, define the following parameters:

￭ Time
Moment when the gradient command is executed.

￭ Eluent A - D
Define the proportion in the mixing ratio for each eluent. Ensure that the
total of all eluent proportions is 100%.

￭ Curve
Selection of the curve form with which the previous entry in the gradient
table moves to the current entry.

– Linear
If the flow is not modified, then the proportion of eluent changes in a
linear fashion.
If the flow and the proportion of the eluents is modified, then the
proportion of the eluents and the flow change in a linear fashion. The
mixing ratio changes in a nonlinear fashion.

– Step
If the flow is not modified, then the proportion of the eluent remains
at its current value up to the point in time of the next command line.
Then the proportion changes to the value of the next command line
at once.
If the flow and the proportion of the eluents is modified, then the
proportion of the eluents and the flow of the pump remain at their
current value up to the point in time of the next command line. Then
they change to the value of the next command line at once. The mix-
ing ratio changes in the same way.

– Convex 1 - 4 / Concave 1 - 4
If the flow is not modified, then the proportion of the eluent changes
along the selected curve.
If the flow and the proportion of the eluents is modified, then the
flow changes along the selected curve. The proportion of eluents
changes along the selected curve. The mixing ratio changes in a non-
linear fashion.

￭ Flow
Flow rate at which the gradient step is executed.
The maximum permitted flow depends on the spray chamber. Refer to Agi-
lent instructions for your instrument.
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Gradient is executed in Time program with command 'Start Gradient'

 Time [min]  Eluent A [%]  Eluent B [%]  Curve  Flow [ml/min]

Start 100 0 0.800

5.00 100 0 Linear 0.800

10.00 50 50 Linear 0.800

15.00 50 50 Linear 0.800

20.00 100 0 Linear 0.800

0 5 10 15 20

1

0.8

0.6

0.4

0.2

0

OK Cancel

Comment

FlowEluent B
Eluent A

Figure 11 High-pressure gradient – Start parameters

NOTE

If the pressure is below PMin or above PMax, an error is generated and
logged in the Diagnostics file (see "Log files", page 84). The instru-
ment is switched off.

NOTE

Besides the PMax that is defined in the start parameters, there is a
PMax written on the column chip. If these values differ, an error is gen-
erated and logged in the Diagnostics file (see "Log files", page 84) as
soon as the lower of both values is exceeded.

Each column holder is assigned to a high-pressure pump.

￭ Pump 1 – Column holder A
￭ Pump 2 – Column holder B
￭ Pump 3 – Column holder C

See chapter 7.2.2.1, page 25 for an illustration of the column holders.
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7.2.2.9 Dose-in gradient

Pumps

On The high-pressure pump is switched on when you start the method.

Flow Flow of the high-pressure pump when you start the method.

The maximum permitted flow depends on the spray chamber. Refer to Agilent
instructions for your instrument.

Start-up time Define a start-up time for reaching the defined flow rate.

PMin Minimum permitted pressure in the instrument when you start the method.

PMax Maximum permitted pressure in the instrument when you start the method.

Gradient… Click on [Gradient…] to define the gradient profile. Execute the gradient profile
with the time program command Dose-in Gradient. For each step in the gradi-
ent profile, define the following parameters:

￭ Time
Moment when the gradient command is executed.

￭ Ratio
Proportion in the mixing ratio from the dosing device to the flow of the
high-pressure pump.

￭ Curve
Selection of the curve form with which the previous entry in the gradient
table moves to the current entry.

– Linear
The proportion of the eluent from the dosing device changes in a lin-
ear fashion.

– Step
The proportion of the eluent from the dosing device remains at its
current value up to the point in time of the next command line. Then
the proportion changes to the value of the next command line at
once.

￭ Flow
Flow rate at which the gradient is executed.
The maximum permitted flow depends on the spray chamber. Refer to Agi-
lent instructions for your instrument.
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Dose-in gradient [Dosino 1] is executed in Time program with command 'Dose-in Gradient'

Figure 12 Dose-in gradient – Start parameters

NOTE

If the pressure is below PMin or above PMax, an error is generated and
logged in the Diagnostics file (see "Log files", page 84). The instru-
ment is switched off.
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NOTE

Besides the PMax that is defined in the start parameters, there is a
PMax written on the column chip. If these values differ, an error is gen-
erated and logged in the Diagnostics file (see "Log files", page 84) as
soon as the lower of both values is exceeded.

Each column holder is assigned to a high-pressure pump.

￭ Pump 1 – Column holder A
￭ Pump 2 – Column holder B
￭ Pump 3 – Column holder C

See chapter 7.2.2.1, page 25 for an illustration of the column holders.

7.2.3 Time program

7.2.3.1 Injector

Switch injector

Injector Number of the injector.

Position Position of the injector.

￭ Inject
Switches the valve to Inject.

￭ Fill
Switches the valve to Fill.

7.2.3.2 MSM

MSM Step

Execution condition The command is only run if the minimum regeneration time has been reached or
exceeded.

MSM Number of the MSM.

Minimal regeneration

time Time that must have elapsed since the last stepping.

7.2.3.3 Peristaltic pump

Set peristaltic

Pump on Switches on the peristaltic pump and sets the value for the pump rate.

Pump Number of the peristaltic pump.
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Rate Rate of the peristaltic pump.

7.2.3.4 High-pressure pump

Measure Pressure

Pump Number of the pump.

7.2.3.5 Remote Box

Set Lines

With this time program command, the IC instrument sends a signal to the Agi-
lent ICP-MS to start data acquisition.

MSB port The Remote Box is always connected to MSB port 1 of the IC instrument.

Output signal Input of the binary pattern for the output signal of exactly 14 bits.

The output lines are numbered from right to left:
13-12-11-10-9-8-7-6-5-4-3-2-1-0

Use the following output lines:

￭ Shutdown signal: Output line 8 (*****p********)
￭ Start signal: Output line 10 (***p**********)

0 = Output line deactivated

1 = Output line activated

* = Retain the status of the output line

p = set pulse (pulse length = 200 ms).

If you add a time program command to activate the output line (*****1********),
always add the corresponding command to deactivate the output line again
(*****0********).

Example:

*****p********: Output line 8 of the IC instrument sends a shutdown signal of
the defined pulse length to the Agilent ICP-MS.

NOTE

If you shut down the plasma with the command Set Lines or by disa-
bling the button [Plasma] in MassHunter, the IC continues to run.
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Scan Lines

The IC instrument receives signals from the Agilent ICP-MS via remote settings.
The command Scan Lines is not necessary.

MSB port The Remote Box is always connected to MSB port 1 of the IC instrument.

Input signal Input of the binary pattern for the output signal of exactly 8 bits.

The input lines are numbered from right to left: 7-6-5-4-3-2-1-0

Timeout If Timeout is activated, then the time program is continued as soon as either
the requested input signal has been received or the waiting time has expired. If
the waiting time expires, the run is aborted.

If Timeout is not activated, then the time program waits indefinitely for an
input signal.

7.2.3.6 High-pressure gradient

Start Gradient

Start Gradient Executes the gradient profile that was defined in the start parameters under Set-
tings (see chapter 7.2.2.8, page 28).

NOTE

Ensure that the gradient is executed immediately after the injection.
Therefore, the time program entry for Start Gradient must be placed
immediately after the entry for Switch injector to Inject position.

7.2.3.7 Dose-in gradient

Dose-in Gradient

Executes the gradient profile that was defined in the start parameters.

MSB The Dosino for the Dose-in gradient is always connected to MSB port 2 of the IC
instrument.

NOTE

Ensure that the gradient is executed immediately after the injection.
Therefore, the time program entry for Dose-in gradient must be
placed immediately after the entry for Switch injector to Inject posi-
tion.
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7.2.4 Manual control

7.2.4.1 High-pressure pump

High-pressure pump 

Pump set flow ▶

Flow Flow of the high-pressure pump.

The maximum permitted flow depends on the spray chamber. Refer to Agilent
instructions for your instrument.

PMin Minimum permitted pressure in the instrument.

PMax Maximum permitted pressure in the instrument.

Pump off Switches off the high-pressure pump.

NOTE

Besides the PMax that is defined in the manual control, there is a PMax
written on the column chip. If these values differ, an error is generated
and logged in the Diagnostics file (see "Log files", page 84) as soon
as the lower of these values is exceeded.

Each column holder is assigned to a high-pressure pump.

￭ Pump 1 – Column holder A
￭ Pump 2 – Column holder B
￭ Pump 3 – Column holder C

See chapter 7.2.2.1, page 25 for an illustration of the column holders.

NOTE

If the high-pressure pump is used for a Dose-in gradient, this is indica-
ted with D1 in the icon.
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7.2.4.2 Injector 

Injector 

Injector Inject Switches the valve to Inject.

Injector Fill Switches the valve to Fill.

7.2.4.3 MSM

MSM 

MSM Step The MSM steps. The time since the last step is reset.

With Dosino regeneration, the default dosing rate of 1.0 mL/min is applied. It is
not possible to change the dosing rate in manual control. If you want to use a
different dosing rate, edit the dosing rate in the MSM start parameters (see
chapter 7.2.2.3, page 27) and send the method to the instrument.

MSM AutoStep ▶ Automatic stepping of the rotor to the next position starts.

Interval Time interval between 2 sequential automatic rotor stepping operations.

With Dosino regeneration, the default dosing rate of 1.0 mL/min is applied. It is
not possible to change the dosing rate in manual control. If you want to use a
different dosing rate, edit the dosing rate in the MSM start parameters (see
chapter 7.2.2.3, page 27) and send the method to the instrument.

MSM AutoStep off Automatic stepping of the rotor to the next position stops.

NOTE

If the MSM is regenerated with Dosino regeneration, this is indicated
with M1 in the icon.
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7.2.4.4 MCS

MCS

MCS On Switches on the MCS.

MCS Off Switches off the MCS.

7.2.4.5 Degasser

Degasser

Degasser On Switches on the degasser.

Degasser Off Switches off the degasser.

7.2.4.6 Peristaltic pump

Peristaltic pump 

Peristaltic pump set

rate Rate of the peristaltic pump when you start the hardware.

Peristaltic pump off Switches off the peristaltic pump.

7.2.4.7 Thermostat

Thermostat 

Thermostat set

temperature  ▶

Temperature Temperature of the thermostat.

The red icon indicates that the thermostat is still warming up.

As soon as the defined temperature has been reached, the icon turns black.

Thermostat off Switches off the thermostat.
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7.2.4.8 Remote Box

Remote Box 

MSB port The Remote Box is always connected to MSB port 1 of the IC instrument.

Output signal The output signal is read-only.

Input of the binary pattern for the output signal of exactly 14 bits.

The output lines are numbered from right to left:
13-12-11-10-9-8-7-6-5-4-3-2-1-0

Use the following output line:

￭ Shutdown signal: Output line 8 (*****p********)

0 = Output line deactivated

1 = Output line activated

* = Retain the status of the output line

p = set pulse (pulse length = 200 ms).

If you add a time program command to activate the output line (*****1********),
always add the corresponding command to deactivate the output line again
(*****0********).

Example:

*****p********: Output line 8 of the IC instrument sends a shutdown signal of
the defined pulse length to the Agilent ICP-MS.

NOTE

If you shut down the plasma with the command Set Lines or by disa-
bling the button [Plasma] in MassHunter, the IC continues to run.

7.2.4.9 High-pressure gradient

High-pressure gradient

pump                        

Pump set flow ▶

Flow Flow of the gradient pump.

The maximum permitted flow depends on the spray chamber. Refer to Agilent
instructions for your instrument.

PMin Minimum permitted pressure in the instrument.
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The high-pressure gradient pump consists of several individual high-pressure
pumps. If the pressure of 1 individual high-pressure pump falls below PMin, an
error is generated and logged in the Diagnostics file (see "Log files", page
84).

PMax Maximum permitted pressure in the instrument.

The high-pressure gradient pump consists of several individual high-pressure
pumps. If the pressure of 1 individual high-pressure pump exceeds PMax, an
error is generated and logged in the Diagnostics file (see "Log files", page
84).

Pump off Switches off the gradient pump.

The extended status panel displays the Pump gradient flow. The pump
gradient flow is the sum of the flows of all pumps that are part of the
high-pressure gradient. If the instrument also contains a Dose-in gradient,
then the flow of the respective pump is shown below the pump icon and
in the extended table as Pump x flow. The flow of the Dose-in gradient
pump is not part of the pump gradient flow.

NOTE

Besides the PMax that is defined in the manual control, there is a PMax
written on the column chip. If these values differ, an error is generated
and logged in the Diagnostics file (see "Log files", page 84) as soon
as the lower of these values is exceeded.

Each column holder is assigned to a high-pressure pump.

￭ Pump 1 – Column holder A
￭ Pump 2 – Column holder B
￭ Pump 3 – Column holder C

See chapter 7.2.2.1, page 25 for an illustration of the column holders.

7.2.4.10 Dose-in gradient

7.2.4.10.1 High-pressure pump

High-pressure pump 

Pump set flow ▶

Flow Flow of the high-pressure pump.

The maximum permitted flow depends on the spray chamber. Refer to Agilent
instructions for your instrument.
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PMin Minimum permitted pressure in the instrument.

PMax Maximum permitted pressure in the instrument.

Pump off Switches off the high-pressure pump.

NOTE

Besides the PMax that is defined in the manual control, there is a PMax
written on the column chip. If these values differ, an error is generated
and logged in the Diagnostics file (see "Log files", page 84) as soon
as the lower of these values is exceeded.

Each column holder is assigned to a high-pressure pump.

￭ Pump 1 – Column holder A
￭ Pump 2 – Column holder B
￭ Pump 3 – Column holder C

See chapter 7.2.2.1, page 25 for an illustration of the column holders.

NOTE

If the high-pressure pump is used for a Dose-in gradient, this is indica-
ted with D1 in the icon.

7.2.4.10.2 Dosing device

Dosing device 

Aspirate ▶ Aspirates the specified volume via the defined port. There is no automatic filling
beforehand or afterwards.

Port Port for aspirating the sample.

Rate Rate for aspirating the sample.

Volume Volume to aspirate.

Dosing ▶ Doses the specified volume via the defined port. There is automatic filling
beforehand or afterwards via the configured port (see chapter 7.6.1, page 63).
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Port Port for dosing the sample.

Rate Rate for dosing the sample.

Filling Rate Rate for filling the cylinder after dosing the sample.

Volume Volume to dose and fill in the cylinder.

Empty Empties the cylinder and all tubings of the dosing unit.

The parameters for emptying the dosing unit are defined in the configuration
(see chapter 7.6.1, page 63).

Fill ▶ Fills the cylinder via the specified port.

Port Port for filling the cylinder.

Rate Rate for filling the cylinder.

Move to exchange

position ▶
Fills the cylinder via the specified port first. Then rotates the valve disk to Port 2.
The Dosino can be removed from the dosing unit.

Port Port for filling the cylinder.

Rate Rate for filling the cylinder.

Prepare Rinses the cylinder and all tubings of the dosing unit with the solution that is
connected to the fill port.

The parameters for preparing the dosing unit are defined in the configuration
(see chapter 7.6.1, page 63).

Stop Dosino Stops the dosing device.

NOTE

If the dosing device is used for Dosino regeneration, this is indicated
with M1 in the icon.

If the dosing device is used for a Dose-in gradient, this is indicated with
D1 in the icon.
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7.3 858 Professional Sample Processor

The 858 Professional Sample Processor is conceived for preparing samples
for ion chromatography.

The equipment with a Swing Head with a robotic arm makes it possible to
approach any given point on a sample rack. As a result, the number and
sequencing of the samples on the sample rack is almost unlimited.

Optionally, you can combine the 858 Professional Sample Processor with a
Liquid Handling Station to rinse the needle and dilute samples.

7.3.1 Configuration

858 Professional Sample

Processor

Communication The following parameters are entered automatically:

￭ Device name
￭ Type ID
￭ Serial number

Options ▶

MSB The 800 Dosino can be selected as an MSB device. Up to 3 Dosinos can be
connected to the 858 Professional Sample Processor.

Click on [Configure] to set further parameters (see chapter 7.6.1, page 63).

Misc The rack is detected automatically.

The stirrer is deactivated by default. If you want to use the stirrer, then activate
the stirrer.

7.3.2 Configuration of the lift positions
Configure the work position of the 858 Professional Sample Processor.

If you use a Liquid Handling Station, configure the external positions of
the 858 Professional Sample Processor.

Therefore, right-click on MetrohmIC and select Settings. The Settings
dialog opens.

The external positions on the Liquid Handling Station depend on the exact
position of the Liquid Handling Station. Therefore, these lift positions have
to be configured individually for each instrument.

The following lift positions can be defined:

￭ Work position
Position for locations on the rack. You can adjust the immersion depth.
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￭ Positions on the Liquid Handling Station. You can adjust the immersion
depth and the angle.

– Rinsing unit – Rinse
– Rinsing unit – Disposal
– Dilution unit – Special
– Dilution unit – Standard

Dilution unit – Special and Dilution unit – Standard have the same
angle setting. The difference between them lies in their immersion
depths.

3 + 4

2

1

Figure 13 Positions on the Liquid Handling Station

1 Rinsing unit – Rinse 2 Rinsing unit – Disposal

3 Dilution unit – Special 4 Dilution unit – Standard

NOTE

Before moving the arm, the needle is lifted to an immersion depth of
0 mm automatically. This prevents the needle from colliding with the
Liquid Handling Station or with a vial.

Table 4 Lift positions – Input values

Lift position Depth Angle

Work position Range: 0–125 mm

Default: 125 mm

-
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Lift position Depth Angle

Rinsing unit – Rinse Range: 0–125 mm

Default: 125 mm

Range: 8.5–117.0°

Default: 108.5°

Rinsing unit – Disposal Range: 0–50 mm

Default: 50 mm

Range: 8.5–117.0°

Default: 109.5°

Dilution unit – Special Range: 0–25 mm

Default: 25 mm

Range: 8.5–117.0°

Default: 116.6°

Dilution unit –
Standard

Range: 0–50 mm

Default: 50 mm

Range: 8.5–117.0°

Default: 116.6°

Example: Configure the lift position Rinsing unit – Rinse

 

1 Enter the estimated angle value for the lift position Rinsing unit –
Rinse in Manual Control.

Click on [Move].

Lift positions
Depth Angle

Rinsing unit - Rinse:

Manual Control:

Assign from Manual

Move

The needle is lifted to 0 mm. Then, the arm of the 858 Professional
Sample Processor moves to the position that you entered in Manual
Control.

 

2 Check whether the needle is centered over the position Rinsing unit
– Rinse.

 

3 If you are not sure whether the angle is set correctly, lower the nee-
dle a bit (approximately 10 mm). Set the depth to 10 mm in Manual
Control.

Click on [Move].
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4 Repeat steps 1–3 until you find the correct position.

 

5 Enter the desired depth for the lift position Rinsing unit – Rinse in
Manual Control.

 

6 Click on [Assign from Manual] next to Rinsing unit – Rinse
position to transfer the values from Manual Control to Rinsing
unit - Rinse.

 

7 Repeat this procedure for all positions on the Liquid Handling Station.

7.3.3 Start parameters

7.3.3.1 Stirrer

Stirrer

On The stirrer is switched on when you start the method.

Rate Rate of the stirrer.

7.3.3.2 Peristaltic pump

Peristaltic pump 1

On The peristaltic pump is switched on when you start the method.

Rate Rate of the peristaltic pump when you start the method.

7.3.4 Time program

7.3.4.1 858 Robotic arm and sample rack

Move

Position type Type of target position.

￭ Vial from Sequence
￭ Vial from Method
￭ External Position
￭ (Vial from Sequence +1)

This position type has no use.

External Position Number of the external position.

Configure the external positions in the Settings (see chapter 7.3.2, page 43).

Vial Number of the vial on the rack.
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Lift position ￭ Home
Home position is always 0.

￭ Work
Configure the work position in the Settings (see chapter 7.3.2, page 43).
The sample is aspirated at this lift position.

￭ User Defined
The user can define an additional position.

Depth Immersion depth of the needle.

This input field is only active if the lift position User Defined is selected.

7.3.4.2 Stirrer

Set stirrer

Stirrer on

Rate Rate of the stirrer.

NOTE

If you run a method with stirrer commands on an instrument without
stirrer, then the time program of the 858 Professional Sample Processor
is deleted completely. To adjust a method with stirrer commands to run
it on an instrument without stirrer, proceed as follows:

Activate the stirrer in the configuration of the 858 Professional Sample
Processor. Open the method. Remove the stirrer commands. Save the
method. Now you can run the adapted method on an instrument with-
out stirrer.

7.3.4.3 Peristaltic pump

Set peristaltic

Pump on Switches on the peristaltic pump and sets the value for the pump rate.

Pump Number of the peristaltic pump.

Rate Rate of the peristaltic pump.
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7.3.5 Manual control

7.3.5.1 858 Robotic arm and sample rack

Robotic arm and sample

rack

Move ▶

Position type Type of target position.

￭ Rack
￭ External Position

Configure the external positions in the Settings (see chapter 7.3.2, page
43).

External posi-

tion
Number of the external position.

This input field is only active if the position type External position is selected.

Vial Number of the vial on the rack.

This input field is only active if the position type Rack is selected.

Lift position ￭ Home
Home position is always 0.

￭ Work
The sample is aspirated at this lift position.
Configure the work position in the Settings (see chapter 7.3.2, page 43).

￭ User Defined
The user can define an additional position.

Depth Immersion depth of the needle.

This input field is only active if the lift position User defined is selected.

Initialize Rack Initializes the rack.

7.3.5.2 Stirrer

Stirrer

Stirrer set rate ▶

Rate Rate of the stirrer when you start the hardware.

Stirrer off Switches off the stirrer.
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7.3.5.3 Peristaltic pump

Peristaltic pump 

Peristaltic pump set

rate Rate of the peristaltic pump when you start the hardware.

Peristaltic pump off Switches off the peristaltic pump.

7.4 889 IC Sample Center

The 889 IC Sample Center is a robust autosampler for high sample
throughput and small sample volumes. The 889 IC Sample Center works
according to the x-y-z principle and with high-resolution injection control
for precise sample delivery.

The optional cooling function cools thermosensitive samples.

NOTE

The 889 IC Sample Center is available in 4 versions which differ in the
combination of integrated modules. In this help, all parameters and
commands are described. However, depending on your product ver-
sion, you may not be able to see all commands and parameters.

7.4.1 Configuration

889 IC Sample Center

Communication The following parameters are entered automatically:

￭ Device name
￭ Type ID
￭ Serial number

You cannot find the serial number of the 889 IC Sample Center on the mod-
ule. Contact a Metrohm service engineer, if you need to know the serial
number of your 889 IC Sample Center.

Options ▶

Misc Syringe and Injector are only available for 2.889.0010 and 2.889.0020.

Enter the following parameters:

￭ Syringe volume
Volume of the syringe.
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￭ Buffer loop
Volume of the buffer loop.

￭ Sample loop
Volume of the sample loop of the injection valve.

￭ Needle to valve
Whole volume, from the needle tip to the injection valve.
The needle is supplied together with the necessary capillary. The capillary is
labeled with the volume in μL. Put this value in here.

The syringe volume and the buffer loop volume have to match. Ensure that the
volumes correspond to one of the following combinations:

￭ Syringe volume = 250 µL
Buffer loop volume = 500 µL

￭ Syringe volume = 500 µL
Buffer loop volume = 1'000 µL

￭ Syringe volume = 1'000 µL
Buffer loop volume = 2'000 µL

Refer to the manual 8.889.8001 IC Sample Center for further information.

Racks ￭ Left rack
Select a rack type.

￭ Right rack
Select a rack type.

Select the same rack type for both rack holders or a combination with None
and any rack type.

The racks can also be changed in manual control (see chapter 7.4.4.3, page
56).

7.4.2 Start parameters

7.4.2.1 Cooling

Cooling

On The cooling is switched on when you start the method.

Temperature Temperature that is set for the cooling when you start the method.

Wait for Stable

Temperature A run does not start before the set temperature has been reached and is stable.

7.4.2.2 Injector

Injector

Position Position of the injector when the run starts.

￭ Inject
Switches the valve to Inject.
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￭ Fill
Switches the valve to Fill.

￭ Maintain Current
The valve maintains its current position.

7.4.2.3 Compressor

Compressor

On The compressor is switched on when you start the method.

7.4.3 Time program

7.4.3.1 889 Sample rack and needle

Move

Position type Type of target position.

￭ Wash
￭ Rack
￭ Waste
￭ Vial from Sequence
￭ (Vial from Sequence +1)

This position type has no use.

Rack ￭ Left
￭ Right

This input field is only active if the position type Rack is selected.

Row This input field is only active if the position type Rack is selected.

Column This input field is only active if the position type Rack is selected.

Needle position ￭ Home
Home position is always 0.

￭ Work

This input field is only active if the position type Rack is selected.

Depth Immersion depth of the needle.

This input field is only active if the position type Rack and the needle position
Work is selected.
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7.4.3.2 Injector

Switch injector

Position Position of the injector.

￭ Inject
Switches the valve to Inject.

￭ Fill
Switches the valve to Fill.

7.4.3.3 889 IC Sample Center

Full loop injection

Rinsing volume Volume for rinsing.

Needle height Distance of the needle tip from the bottom of the vial.

Syringe Speed Speed at which the syringe plunger is moved.

￭ Slow
￭ Normal
￭ Fast

Air segment If selected, then an air segment separates the sample from the content of the
wash bottle (usually UPW).

Headspace pressure If selected, then overpressure is channeled in through the air needle. This
ensures that no air or steam bubbles form while aspirating the sample. Only
select this option if you use vials with septa.

Wash after injection If selected, then the washing procedure is carried out after the injection.

Partial loop injection

Injection volume

Input
￭ From method
￭ From sample data
￭ Injection volume

The default setting for this input field is From method.

Metrohm recommends to change the setting to From sample data.

Injection volume Define the injection volume manually.

Maximum injection volume = 0.5 x sample loop volume

The sample loop volume is defined in the configuration of the 889 IC Sample
Center (see chapter 7.4.1, page 49).

Refer to the manual 8.889.8001 IC Sample Center for further information
regarding the injection volume.
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If the Injection volume Input From method is selected, the injection volume
has to be > 0 µL.

Rinsing volume Volume for rinsing.

Needle height Distance of the needle tip from the bottom of the vial.

Syringe Speed Speed at which the syringe plunger is moved.

￭ Slow
￭ Normal
￭ Fast

Air segment If selected, then an air segment separates the sample from the content of the
wash bottle (usually UPW).

Headspace pressure If selected, then overpressure is channeled in through the air needle. This
ensures that no air or steam bubbles form while aspirating the sample. Only
select this option if you use vials with septa.

Wash after injection If selected, then the washing procedure is carried out after the injection.

Pickup injection

Injection volume

Input
￭ From sample data
￭ Injection volume

Injection volume Define the injection volume manually.

Maximum injection volume = (sample loop volume - 3 x needle volume) / 2

The sample loop volume and needle volume are defined in the configuration of
the 889 IC Sample Center (see chapter 7.4.1, page 49).

Refer to the manual 8.889.8001 IC Sample Center for further information
regarding the injection volume.

This input field is only active if the injection volume input Injection volume is
selected.

Transport volume Volume of transport solution.

Needle height Distance of the needle tip from the bottom of the vial.

Syringe Speed Speed at which the syringe plunger is moved.

￭ Slow
￭ Normal
￭ Fast

Air segment If selected, then an air segment separates the sample from the content of the
wash bottle (usually UPW).
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Headspace pressure If selected, then overpressure is channeled in through the air needle. This
ensures that no air or steam bubbles form while aspirating the sample. Only
select this option if you use vials with septa.

Wash after injection If selected, then the washing procedure is carried out after the injection.

NOTE

After injecting the sample, the 889 IC Sample Center automatically sets
an event called Injection Performed. The event wait does not need to
be entered manually. The corresponding event wait in the time program
of the 930/940 IC must be set manually. In the time program of the
930/940 IC, enter a command to start measuring after the event wait.

Wash

Performs the washing procedure.

7.4.3.4 Syringe

Syringe change port

Position The syringe valve port rotates to the selected position.

￭ Needle
￭ Wash
￭ Waste

Fill

Syringe Port Port for filling the syringe.

￭ Needle
￭ Wash
￭ Waste

Syringe Speed Speed at which the syringe plunger is moved.

￭ Slow
￭ Normal
￭ Fast

Eject

Syringe Port Port for ejecting the content of the syringe.

￭ Needle
￭ Wash



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 7 Instrument parameters

Metrohm IC Driver 1.0, ICP-MS MassHunter ￭￭￭￭￭￭￭￭ 55

￭ Waste

Syringe Speed Speed at which the syringe plunger is moved.

￭ Slow
￭ Normal
￭ Fast

Aspirate

Volume Volume to aspirate. The entered volume must not exceed the actual volume of
the installed syringe. The maximum volume that can be aspirated depends on
the current position of the syringe plunger.

Syringe Port Port for aspirating the sample.

￭ Needle
￭ Wash
￭ Waste

Syringe Speed Port for aspirating the sample.

￭ Slow
￭ Normal
￭ Fast

Dispense

Volume Volume to dispense. The entered volume must not exceed the actual volume of
the installed syringe. The maximum volume that can be dispensed depends on
the current position of the syringe plunger.

Syringe Port Port for dispensing the sample.

￭ Needle
￭ Wash
￭ Waste

Syringe Speed Speed at which the syringe plunger is moved.

￭ Slow
￭ Normal
￭ Fast
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7.4.4 Manual control

7.4.4.1 Injector 

Injector 

Injector Inject Switches the valve to Inject.

Injector Fill Switches the valve to Fill.

7.4.4.2 Cooling

Cooling 

Cooling set temp-

erature ▶

Temperature Temperature of the thermostat.

The blue icon indicates that the cooling is still cooling down.

As soon as the defined temperature has been reached, the icon turns black.

Cooling off Switches off the thermostat.

7.4.4.3 889 Sample rack and needle

Sample rack and needle

Move ▶

Position type Type of target position.

￭ Rack
The vial number has the following format:
LA1 = Left rack, Row A, Column 1
RB2 = Right rack, Row B, Column 2

￭ Wash Position
￭ Waste Position

Rack ￭ Left
￭ Right

This input field is only active if the position type Rack is selected.
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Row This input field is only active if the position type Rack is selected.

Column This input field is only active if the position type Rack is selected.

Needle ￭ Home
The uppermost stop of the lift.

￭ Work
The sample is aspirated at this lift position.
If the position type Wash Position or Waste Position is selected, then the
needle is always in Work position.

Depth Immersion depth of the needle.

This input field is only active if the position type Rack and the needle position
Work are selected.

Home The needle goes into Home position

Assign Racks ▶ Select the same rack type for both rack holders or a combination with None
and any rack type.

Left rack Select a rack type for the left rack.

Right rack Select a rack type for the right rack.

Exchange Rack Moves the rack to exchange position in order to exchange the racks.

Exchange Needle Moves the needle to exchange position in order to exchange the needle. For
more information on exchanging the needle, refer to 8.889.8001 Manual 889
IC Sample Center or 8.889.8004 Manual 889 IC Sample Center Basic.

Remove both racks before moving the needle to exchange position.

7.4.4.4 889 Syringe, Compressor, Washing procedure

Syringe, Compressor,

Washing procedure

To access these commands, right-click in the background area beside the 889
icons (orange frame in the image below).
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State of 889 units

Syringe Fill
Syringe Eject
Syringe Aspirate
Syringe Dispense
Start Wash
Compressor On
Reset

Syringe Fill ▶ Fills the syringe completely via the specified port.

Port Port for filling the syringe.

￭ Needle
￭ Wash
￭ Waste

Speed Speed at which the syringe plunger is moved.

￭ Fast
￭ Normal
￭ Slow

This input field is only active if the port Needle is selected.

Syringe Eject ▶ Ejects the content of the syringe via the specified port.

Port Port for ejecting the content of the syringe.

￭ Needle
￭ Wash
￭ Waste

Speed Speed at which the syringe plunger is moved.

￭ Fast
￭ Normal
￭ Slow

This input field is only active if the port Needle is selected.

Syringe Aspirate ▶ Aspirates the specified volume via the defined port.

Volume Volume to aspirate. The maximum volume that can be aspirated depends on the
current position of the syringe plunger.

Port Port for aspirating the sample.
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￭ Needle
￭ Wash
￭ Waste

Speed Speed at which the syringe plunger is moved.

￭ Fast
￭ Normal
￭ Slow

This input field is only active if the port Needle is selected.

Syringe Dispense ▶ Dispenses the specified volume via the defined port.

Volume Volume to dispense. The maximum volume that can be dispensed depends on
the current position of the syringe plunger.

Port Port for dispensing the sample.

￭ Needle
￭ Wash
￭ Waste

Speed Speed at which the syringe plunger is moved.

￭ Fast
￭ Normal
￭ Slow

This input field is only active if the port Needle is selected.

Compressor On Switches on the compressor.

Compressor Off Switches off the compressor.

Start Wash Starts the washing procedure.

Stop Wash Stops the washing procedure.

Reset Resets the module.
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7.5 919 IC Autosampler plus

The 919 IC Autosampler plus fulfills the requirements of laboratories with
medium sample numbers. The 919 IC Autosampler plus contains the fol-
lowing rack for 56 samples with a vessel volume of up to 11 mL: Sample
rack, 56 x 11 mL and 1 x 250 mL (PVC) (6.2041.510). The rack can be
removed.

7.5.1 Configuration

Communication The following parameters are entered automatically:

￭ Device name
￭ Type ID
￭ Serial number

When you launch the instrument, Metrohm IC Driver, ICP-MS MassHunter
checks the type ID and serial number. It is not possible to launch the instrument
if the actual type ID or serial number do not match the configured type ID or
serial number.

Options ▶

MSB The 800 Dosino can be selected as an MSB device. Up to 3 Dosinos can be
connected to the 919 IC Autosampler plus.

Click on [Configure] to set further parameters (see chapter 7.6.1, page 63).

Misc The rack is detected automatically.

7.5.2 Configuration of the lift positions
Configure the work position of the 919 IC Autosampler plus.

The Work Position is the position for locations on the rack. You can
adjust the immersion depth.

Therefore, right-click on MetrohmIC and select Settings. The Settings
dialog appears.

Configure the Work Position

 

1 Enter the desired depth for the Work Position in Manual Control
(range: 0–125 mm, default value: 125 mm).

Click on [Move].
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Lift positions
Depth

Work Position:

Manual Control:

Assign from Manual

Move

The needle of the 919 IC Autosampler plus is lowered to the depth
that you entered in Manual Control.

 

2 Click on [Assign from Manual] next to Work Position to transfer
the value from Manual Control to Work Position.

7.5.3 Start parameters

7.5.3.1 Peristaltic pump

Peristaltic pump 1

On The peristaltic pump is switched on when you start the method.

Rate Rate of the peristaltic pump when you start the method.

7.5.4 Time program

7.5.4.1 Tower and sample rack

Move

Position type Type of target position.

￭ Vial from Sequence
￭ Vial from Method
￭ (Vial from Sequence +1)

This position type has no use.

Vial Number of the vial on the rack.

Lift position ￭ Home
Home position is always 0.

￭ Work
The sample is aspirated at this lift position.
Configure the work position in the Settings (see chapter 7.5.2, page 60).

￭ User Defined
The user can define an additional position.

Depth Immersion depth of the needle.
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This input field is only active if the lift position User Defined is selected.

7.5.4.2 Peristaltic pump

Set peristaltic

Pump on Switches on the peristaltic pump and sets the value for the pump rate.

Pump Number of the peristaltic pump.

Rate Rate of the peristaltic pump.

7.5.5 Manual control

7.5.5.1 Tower and sample rack

Tower and sample rack

Move ▶

Vial Number of the vial on the rack.

Lift position ￭ Home
Home position is always 0.

￭ Work
The sample is aspirated at this lift position.
Configure the work position in the Settings (see chapter 7.5.2, page 60).

￭ User Defined
The user can define an additional position.

Depth Immersion depth of the needle.

This input field is only active if the lift position User defined is selected.

Initialize Rack Initializes the rack.

7.5.5.2 Peristaltic pump

Peristaltic pump 

Peristaltic pump set

rate Rate of the peristaltic pump when you start the hardware.

Peristaltic pump off Switches off the peristaltic pump.
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7.6 Dosing device

The dosing device consists of an 800 Dosino that serves as dosing drive
and a dosing unit. The dosing unit is available with 4 cylinder sizes: 5 mL,
10 mL, 20 mL and 50 mL.

Use the dosing device for liquid handling tasks.

The 4 ports of the dosing unit are designed for flexible use.

7.6.1 Configuration

Dosing device

Serial Number The serial number is entered automatically.

This field contains the serial number of the 800 Dosino, not the serial number of
the dosing unit.

Volume The volume of the cylinder is entered automatically.

Tubing Parameters ▶ Parameters for the tubing that is connected to the dosing unit.

These parameters are important for the correct execution of the commands Pre-
pare and Empty because they take the volumes of the tubing connections into
account.

Port Port to be used as dosing port. Assign a port 1 - 4 to each dosing port.

Length (cm) Length of the tubing on the dosing port.

Dosing Rate

(mL/min)
Diameter of the dosing rate.

The value depends on the volume of the dosing unit. When the function is car-
ried out, the dosing rate is automatically decreased to the highest possible value.

Preparation Parame-

ters
Configure the parameters for preparing and emptying the dosing unit (see chap-
ter 7.6.3, page 66), (see chapter 7.6.2, page 64).

Dosing port through which the cylinder content is ejected during preparation
and emptying.

Dosing port for the Prepare and Empty commands is always Dosing Port 1.

Valve ▶

Rotation Direc-

tion
Rotating direction of the valve disk.

￭ Ascending
The valve disk rotates in the direction of ascending port numbers.

￭ Descending
The valve disk rotates in the direction of descending port numbers.



7.6 Dosing device ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

64 ￭￭￭￭￭￭￭￭ Metrohm IC Driver 1.0, ICP-MS MassHunter

￭ Automatic
The valve disk rotates in the direction with the shortest path.

￭ Not Over
The valve disk does not cross the specified port during rotation.

Not Over This field gets activated if you select the rotation direction Not Over.

This port is not crossed during rotation.

7.6.2 Time program

Aspirate

Aspirates the specified volume via the defined port. There is no automatic filling
beforehand or afterwards.

MSB Number of the MSB port the Dosino is connected to.

Port Port for aspirating the sample.

Rate Rate for aspirating the sample.

Volume mode Select a volume mode from the drop-down list.

￭ from method
￭ Injection volume

The injection volume is defined in the sequence.

Volume This input field is only active if the volume mode from method is selected.

User defined volume to aspirate.

Dose

Doses the specified volume via the defined port. There is automatic filling
beforehand or afterwards via the configured port (see chapter 7.6.1, page 63).

MSB Number of the MSB port the Dosino is connected to.

Port Port for dosing the sample.

Rate Rate for dosing the sample.

Filling rate Rate for filling the cylinder after dosing the sample.

Volume mode Select a volume mode from the drop-down list.

￭ from method
￭ Injection volume

The injection volume is defined in the sequence.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 7 Instrument parameters

Metrohm IC Driver 1.0, ICP-MS MassHunter ￭￭￭￭￭￭￭￭ 65

Volume This input field is only active if the volume mode from method is selected.

User defined volume to dose.

Eject to end volume

Ejects the entire content of the cylinder via the specified port.

MSB Number of the MSB port the Dosino is connected to.

Port Port for ejecting the entire content of the cylinder.

Rate Rate for ejecting the sample.

Fill

Fills the cylinder via the specified port.

MSB Number of the MSB port the Dosino is connected to.

Port Port for filling the cylinder.

Rate Rate for filling the cylinder.

Change port

The valve rotates to the specified port.

MSB Number of the MSB port the Dosino is connected to.

Port The valve is switched to the defined port.

Empty

Empties the cylinder and all tubings of the dosing unit.

Define the parameters for emptying the dosing unit in the configuration (see
chapter 7.6.1, page 63).

MSB Number of the MSB port the Dosino is connected to.

Prepare

Rinses the cylinder and all tubings of the dosing unit with the solution that is
connected to the fill port.

Define the parameters for preparing the dosing unit in the configuration (see
chapter 7.6.1, page 63).



7.6 Dosing device ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

66 ￭￭￭￭￭￭￭￭ Metrohm IC Driver 1.0, ICP-MS MassHunter

MSB Number of the MSB port the Dosino is connected to.

7.6.3 Manual control

Dosing device

Aspirate ▶ Aspirates the specified volume via the defined port. There is no automatic filling
beforehand or afterwards.

Port Port for aspirating the sample.

Rate Rate for aspirating the sample.

Volume Volume to aspirate.

Dosing ▶ Doses the specified volume via the defined port. There is automatic filling
beforehand or afterwards via the configured port (see chapter 7.6.1, page 63).

Port Port for dosing the sample.

Rate Rate for dosing the sample.

Filling Rate Rate for filling the cylinder after dosing the sample.

Volume Volume to dose and fill in the cylinder.

Empty Empties the cylinder and all tubings of the dosing unit.

The parameters for emptying the dosing unit are defined in the configuration
(see chapter 7.6.1, page 63).

Fill ▶ Fills the cylinder via the specified port.

Port Port for filling the cylinder.

Rate Rate for filling the cylinder.

Move to exchange

position ▶
Fills the cylinder via the specified port first. Then rotates the valve disk to Port 2.
The Dosino can be removed from the dosing unit.

Port Port for filling the cylinder.

Rate Rate for filling the cylinder.

Prepare Rinses the cylinder and all tubings of the dosing unit with the solution that is
connected to the fill port.
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The parameters for preparing the dosing unit are defined in the configuration
(see chapter 7.6.1, page 63).

Stop Dosino Stops the dosing device.

NOTE

If the dosing device is used for Dosino regeneration, this is indicated
with M1 in the icon.

If the dosing device is used for a Dose-in gradient, this is indicated with
D1 in the icon.
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8 Batch

ICP-MS Instrument Control ▶ Toolbar ▶ Home

NOTE

For further information on batch creation, refer to the MassHunter
Workstation User Guide or the ICP-MS MassHunter Help. To
open the help, press [F1] in the window you want to learn more about.

A batch contains all data that is related to an analysis (e.g., instrument
method, sample list).

Create a batch in order to define the acquisition parameters (see chapter
10, page 72) and create a sequence (see chapter 11, page 74).

Metrohm recommends to create a batch from a batch template. There is a
batch template for each type of Agilent ICP-MS stored in C:\Agilent
\ICPMH\1\DATA\BatchTemplate.

Create a batch

 

1 In the toolbar go to the Home tab. Click on [Create From Tem-
plate].

The file explorer opens.

 

2 Select the batch template for your instrument. Click on [Open].

The Save Batch As dialog opens.

 

3 Enter a batch name. Click on [Create].

The new batch opens in the ICP-MS Instrument Control.
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9 Equilibration

ICP-MS Instrument Control ▶ Hardware ▶ Dashboard ▶ Instrument Method

NOTE

For further information on starting and tuning the Agilent ICP-MS, refer
to the MassHunter Workstation User Guide or the ICP-MS Mass-
Hunter Help. To open the help, press [F1] in the window you want to
learn more about.

Equilibrate the IC instrument

NOTE

Before starting the equilibration, make sure there are no leaks in the IC
instrument. If a leak causes an error during equilibration, both the IC
instrument an the Agilent ICP-MS turn off.

 

1 Navigate to Task Navigator ▶ Hardware ▶ Dashboard. Right-
click on Sample Introduction and select Settings....

The Settings dialog appears.

 

2 In the Sample Introduction selection list, select Other.

Close the dialog with [Close].

 

3 To apply the start parameters defined in your method, click on the

Upload icon .

NOTE

If you use the peristaltic pump of the IC instrument to transfer the
waste from the spray chamber (see "Spray chamber outlet", page
7), switch on the peristaltic pump in the start parameters. The peri-
staltic pump of the IC instrument must always be running while
running the Agilent ICP-MS.

The instrument executes the start parameters. The instrument does
not acquire data.
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Start the Agilent ICP-MS

￭ The peristaltic pump of the IC instrument is running, as it transfers the
waste from the spray chamber.

 

1 Navigate to Task Navigator ▶ Hardware ▶ Dashboard. Right-
click on Sample Introduction and select Settings....

The Settings dialog appears.

 

2 In the Sample Introduction selection list, select PeriPump.

Close the dialog with [Close].

With the sample introduction PeriPump, you have no access to the
IC instrument. The IC instrument continues to run the start parame-
ters.

 

3 Connect the sample inlet of the spray chamber to the tuning solu-
tion.

 

4 To start the plasma and run the ignition sequence, go to the toolbar.
Click on Plasma ▶ Execute Configured Ignition Sequence.

The ignition sequence takes approximately 30 minutes. During the
ignition sequence, the IC instrument continues to equilibrate.

After the ignition sequence, equilibrate the Agilent ICP-MS (see
"Equilibrate the Agilent ICP-MS", page 70).

Equilibrate the Agilent ICP-MS

￭ The peristaltic pump of the IC instrument is running, as it transfers the
waste from the spray chamber.

￭ The sample inlet of the spray chamber is connected to the tuning solu-
tion.

￭ The start-up of the plasma with the ignition sequence has been per-
formed (see "Start the Agilent ICP-MS", page 70).

 

1 To set up the instrument for equilibration, navigate to Task Naviga-
tor ▶ Hardware ▶ Dashboard. Right-click on Sample Introduc-
tion and select Settings....

The Settings dialog appears.

 

2 In the Sample Introduction selection list, select Other.
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Close the dialog with [Close].

Samples will be introduced with the IC instrument.

 

3 To start the equilibration, navigate to Task Naviga-
tor ▶ Startup ▶ User Tune Configuration.

To use the tune for batches later on, click on [Set as Global Tune].

In the tune selection list, select AutoTune. Start the tuning with
[Start AutoTune].

The Agilent ICP-MS performs the tuning.

 

4 In the User Tune Configuration area, click on [Start Signal Mon-
itor] to monitor the baselines of the selected masses.

The equilibration is finished as soon as the baselines are stable.

 

5 Connect the sample inlet of the spray chamber to the eluent outlet
of the IC instrument.
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10 Acquisition parameters

ICP-MS Instrument Control ▶ Acquisition

NOTE

For further information on acquisition parameters, refer to the Mass-
Hunter Workstation User Guide or the ICP-MS MassHunter
Help. To open the help, press [F1] in the window you want to learn
more about.

Access the acquisition parameters via Task Navigator ▶ Acquisition.

To save time, you can set the acquisition parameters while the instrument
is equilibrating.

Set the following acquisition parameters:

Acquisition

Setup ▶

Acq Mode Select TRA.

In the batch templates (see chapter 8, page 68), TRA is predefined.

With the acquisition mode TRA (time-resolved analysis), a measuring curve is
acquired.

Tune Modes Define the tune. To use the tune you performed during equilibration, select the
name of the respective tune (see chapter 9, page 69).

You can select only one tune mode for an IC-ICP/MS analysis.

Element Selection ▶

Select Elements The Select Elements on Periodic Table dialog opens.

Select the desired elements. Confirm with [OK].

Sample Period

[sec]
The sampling period is calculated automatically from the integration time of the
entered elements.

Acq Time [sec] Enter the expected length of the chromatogram.

The acquisition time can be specified in the sample list as well, e.g. if a shorter
acquisition time is sufficient for certain samples (see chapter 11, page 74).

If you use Dosino regeneration, the acquisition time must be at least as long as
the Dosino regeneration time.
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Integration Parame-

ters ▶

Peak table The table contains the parameters for the integration of the measuring point list
and determination of the peak data. If you already know which peaks to expect
(e.g., in routine analysis), enter the peak data for the chosen elements.

Calibration Set the calibration parameters and enter your calibration standards in the table.
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11 Sample list

ICP-MS Instrument Control ▶ Sequence ▶ Sample List

NOTE

For further information on the sample list, refer to the MassHunter
Workstation User Guide or the ICP-MS MassHunter Help. To
open the help, press [F1] in the window you want to learn more about.

Enter your samples in the table.

The fields Sample Name, Vial#, Injection Volume (µL), File Name
and IC Method are mandatory. These fields are only available if you cre-
ated the batch from a batch template (see chapter 8, page 68). To visual-
ize these fields or other fields, the view can be adapted with [Add/
Remove Columns].

In several fields, you can use the Fill Down function. Therefore, select the
cell with the content to be transferred and the cells to be filled down.
Open the context menu and select Fill Down.

You can use the list format or the block list format. Switch between the
formats with the button [Use Block List].

In the block list format, the option [Whole List] is available. Do not use
the option [Whole List]. Otherwise, user-defined fields disappear from
the sample table. If you activated the option [Whole List], click on
[Whole List] again to return to the block list format.

By default, the sample list contains the following columns:

Sample Type If you use the sample type CalStd, data from the calibration table (Acquisi-
tion ▶ Calibration) are applied (see menu "Acquisition", page 72).

Sample Name

Level Enter the level for calibration standards.

Use the same level numbers, you entered in Acquisition ▶ Calibration (see
menu "Acquisition", page 72).

Vial# ▶

858 Professional

Sample Pro-

cessor/919 IC

Autosampler

plus Enter the vial number.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 11 Sample list

Metrohm IC Driver 1.0, ICP-MS MassHunter ￭￭￭￭￭￭￭￭ 75

889 IC Sample

Center
The vial number has the following format:

LA1 = Left rack, Row A, Column 1

RB2 = Right rack, Row B, Column 2

Enter the vial number or select the vial in the vial selector.

The vial selector is a graphical representation of the racks. Open the vial selector
with the arrow in the respective Vial cell.

Ensure that all vial positions entered in the sample table contain a vial. If a posi-
tion contains no vial, the sequence is aborted.

Injection Volume (µL) Enter the injection volume in µL.

Total Dilution Enter the dilution factor.

To calculate the dilution factor, double-click on the cell. In the appearing win-
dow, enter the Sample Weight or Volume and the Final Weight or Vol-
ume. The dilution factor is calculated and entered automatically.

File Name The determination is saved with this name in the database. Each sample requires
a unique file name. If you don't specify a file name, an automatic file name is
assigned.

IC Method Enter the folder path, the method name and the file extension (e.g., C:\Agilent
\ICPMH\1\DATA\7850batch1\Method\Method1.xml).

Copy the folder path from the file explorer. Add a backslash. Copy the method
name including the file extension and add it to the path.

Do not use Fill Down. Otherwise, numbers in the path name are increased by
1 for each sample.

Post-Run Report Define whether a Post-Run-Report should be generated at the end of the deter-
mination (see chapter 14.3, page 81). By default, a Post-Run Report is gener-
ated.

If do not want a Post-Run Report to be generated, enter No.

If you enter Yes, Y, or N, a Post-Run Report is generated. A Post-Run Report is
also generated if you leave the cell blank.

Comment

Validate method

 

1 Validate the method after creating the sample list.

In the toolbar, go to the Home tab. Click on [Validate].

If necessary, correct the sample table.
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2 Save the batch. In the toolbar, go to the File tab. Click on [Save
Batch] or [Save Batch as].

 

3 Click on [Add to Queue] to start data acquisition (see chapter 12,
page 77).
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12 Data acquisition

ICP-MS Instrument Control ▶ Sequence ▶ Sample List

ICP-MS Data Acquisition ▶ Queue ▶ Acquisition Queue

NOTE

For further information on data acquisition, refer to the MassHunter
Workstation User Guide or the ICP-MS MassHunter Help. To
open the help, press [F1] in the window you want to learn more about.

NOTE

Metrohm recommends to monitor the IC instrument in a floating win-
dow. Before starting a determination, open a floating window with the
tabs Method and Manual Control/Status on a second screen or in
the right quarter of the primary screen (see chapter 7.1, page 15).

Start a determination

 

1 Navigate to your sample list (Sequence ▶ Sample List) (see chap-
ter 11, page 74).

 

2 Click on [Add to Queue]. If you have not saved the batch yet, you
are asked to save it now.

The Acquisition Queue window appears. The acquisition will be
started as soon as the previous acquisitions are finished.

At the start of the determination, the ICP-MS Data Analysis pro-
gram part opens (see chapter 13, page 79).

 

3 To shut down the IC instrument and the Agilent ICP-MS after the
batch is finished, activate the option [Plasma Off at End] in the
Acquisition Queue window (see chapter 12, page 77).

If you do not shut down the Agilent ICP-MS with [Plasma Off at
End] the IC instrument and the Agilent ICP-MS remain in their cur-
rent state after the last determination. If the state should deviate
from the current state, run an end method in the last line of the sam-
ple table.
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If you change a method that is used in the running determination, the
change is not applied to the running sample. The change is applied to
subsequent samples.

NOTE

If you stop the acquisition queue with the [Stop] button in the toolbar,
the instrument behaves in the following way:

The running sequence is stopped. The time program of the autosampler
is aborted.

If a gradient is running, the gradient continues until the gradient profile
is completed.

If you click on [Requeue] or [Edit and requeue], the requeued
sequence starts as soon as the gradient profile is complete.

Do not stop the acquisition queue during the first line of the sample list.
Otherwise the sequence gets stuck.

NOTE

889 IC Sample Center - missing vial:

If a vial from the sample table is missing in the 889 IC Sample Center,
data acquisition continues despite the missing vial. The 889 IC Sample
Center is in error state. The baseline is monitored. After the acquisition
time elapsed, the sequence continues with the next line in the sample
list.
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13 Data analysis

NOTE

For information on data analysis, refer to the MassHunter Worksta-
tion User Guide or the ICP-MS MassHunter Help. To open the
help, press [F1] in the window you want to learn more about.
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14 Reports

NOTE

For further information on reports, refer to the MassHunter Worksta-
tion User Guide or the ICP-MS MassHunter Help. To open the
help, press [F1] in the window you want to learn more about.

14.1 Configuration report

After saving the configuration, you can create a configuration report.

Therefore, click on the Print icon  in the Metrohm IC Configuration
dialog.

Metrohm IC Configuration ×

Selected Instruments: ?
Figure 14 Create configuration report

Select a location to store the configuration report as PDF file.

Information on instrument configuration: Instrument configuration

A configuration report contains information on the instrument configura-
tion (e.g., device name, type ID, serial number).

14.2 Method report

After saving the method, you can create a method report. Therefore, click

on the Print icon  on the Instrument Method tab.

?

×MetrohmIC

Instrument Method Manual Control/Status

Method name

Figure 15 Create method report

Select a location to store the method report as PDF file.

Information on method creation: Instrument method

A method report contains information on the following topics:
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￭ Instrument (e.g., device name, type ID, serial number)
￭ Start parameters
￭ Time program commands

14.3 Post-Run Report

ICP-MS Data Analysis ▶ Report

You can create reports with report templates. For analysis with the acquisi-
tion mode TRA select the report template Quantitation report or Chro-
matogram method report.

Define in the sample list whether a Post-Run Report is generated at the
end of a determination (see chapter 11, page 74). If defined accordingly,
a Post-Run Report is generated automatically at the end of a determina-
tion according to the chosen report template.

Post-Run Reports are stored in the batch folder (C:\Agilent\ICPMH\1\DATA
\'Batch name').

The file name corresponds to the following scheme: 'Timestamp computer
time'_ICpostrun.pdf (e.g., 20240130_135910_ICpostrun.pdf)

Regarding Metrohm modules, the Post-Run Report contains information
on the following topics:

￭ Instrument (e.g., device name, type ID, serial number)
￭ Samples (e.g., sample name, volume, vial number)
￭ Instrument method (e.g., method name, date of last modification,

modifier name)
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15 Tips and tricks

Configuration

￭ An instrument may maximally include the following modules:
– 1 IC instrument (930 Compact IC Flex or 940 Professional IC

Vario)
– 1 autosampler (889 IC Sample Center or 858 Professional Sam-

ple Processor or 919 IC Autosampler plus)
– 1 Remote Box MSB: The Remote Box is mandatory in instru-

ments with an Agilent ICP-MS. Together with the IC equipment,
connection Agilent ICP-MS, the Remote Box enables remote
control between the IC instrument and the Agilent ICP-MS. The
Remote Box must be connected to MSB 1 of the IC instrument.

– 1 800 Dosino per IC instrument, 3 800 Dosinos per 858 Pro-
fessional Sample Processor or 919 IC Autosampler plus

– 3 942 Extension Modules Vario per 940 Professional IC Vario
￭ The IC equipment, connection Agilent ICP-MS (6.05330.400) is manda-

tory in instruments with an Agilent ICP-MS. Together with the Remote
Box MSB, the IC equipment, connection Agilent ICP-MS enables
remote control between the IC instrument and the Agilent ICP-MS.

￭ You can use only 1 Dosino with the IC instrument. Only the Dosino
that is connected to the IC instrument can be used for Dosino regener-
ation or a Dose-in gradient.

￭ The stirrer is deactivated by default. If you want to use the stirrer, then
activate the stirrer in manual configuration of the 858 Professional
Sample Processor (see chapter 7.3.1, page 43).

￭ Connect the Dosino to MSB 2 of the IC. Connect the Remote Box to
MSB 1 of the IC.
Do not select the Remote Box as MSB device for the 858 Professional
Sample Processor or 919 IC Autosampler plus.

￭ A high-pressure pump can be used either for a high-pressure gradient
or for a Dose-in gradient or as a normal high-pressure pump. A high-
pressure pump cannot be configured for several functions.

￭ A high-pressure gradient can only be configured for 940 Professional
ICs Vario and for 942 Extensions Modules Vario that are connected to
a 940 Professional IC Vario. At least 2 high-pressure pumps are neces-
sary to configure a high-pressure gradient.

￭ Besides the PMax that is defined in the manual control, there is a PMax
written on the column chip. If these values differ, an error is generated
and logged in the Diagnostics file (see "Log files", page 84) as soon
as the lower of these values is exceeded.
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Connection IC – Agilent ICP-MS

￭ If you use the peristaltic pump of the IC instrument to transfer the
waste from the spray chamber, the peristaltic pump of the IC instru-
ment must always be switched on while running the Agilent ICP-MS.

Method

￭ Ensure that gradients are executed immediately after the injection.
Therefore, the time program entry for Start Gradient must be placed
immediately after the entry for Switch injector to Inject position.

￭ To save time, run 2 commands in parallel. Check the checkbox Paral-
lel. While a command is being executed, the time program already
continues with the next line.

￭ Open a method in a separate window by clicking on Float External
Device Control, before sending the method to the instrument. Other-
wise, the method is no longer visible under Dashboard ▶ Instru-
ment control once you sent the method to the instrument.

￭ If you open the method in a floating window, windows that open
afterwards are positioned behind the floating window. This can result
in a deadlock, in which a window requests an action. All other win-
dows are inactive until this action has been performed. However, the
window that requires an action is inaccessible because it is located
behind the floating window. All windows automatically open in the
middle of the primary screen. To avoid the described problem,
Metrohm recommends to open the floating window on a second
screen or in the right quarter of the primary screen.

￭ The hardware does not switch off automatically if an instrument goes
offline. To ensure that the hardware is off, switch off the hardware
with the power-off button.

￭ In the MSM start parameters, the dosing rate for Dosino regeneration
is calculated from the parameters Volume and Time. If you send the
current method to the instrument to equilibrate the instrument, then
the default dosing rate of 1.0 mL/min is applied for the first MSM step.
For all following MSM steps, the dosing rate from the method is
applied.

Driver error

￭ Some error messages in MassHunter contain the text driver error.
These messages do not refer to the Metrohm IC Driver, ICP-MS Mass-
Hunter. These messages can result from an emergency stop due to a
leak or a hardware problem, for example.
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16 Troubleshooting

Instrument errors

If an error occurs during equilibration or during data acquisition, send the
method to the instrument again. If the error persists, search the diagnos-
tics log (C:\Agilent\ICPMH\LOG\MetrohmIC). If necessary, send the log files
to your regional Metrohm representative (see "Log files", page 84).

Log files

If a problem with your instrument occurs, then the diagnostics log, the log
files for the Agilent ICP-MS or the Metrohm log contain further informa-
tion on the problem.

The diagnostics log contains messages about errors and activities, for
example executing parameters. The diagnostics log states whether the
logged activities were executed successfully or not. In case of a failure or
an error, the diagnostics log provides information on solving the problem
or possible reasons for the failure or error.

Troubleshooting with log files

 

1 Open the diagnostics log.

The diagnostics log is stored in the following folder:
C:\Agilent\ICPMH\LOG\MetrohmIC

The file name is Diagnostics.

 

2 Check if there is a message that provides more information on your
problem.

 

3 If you are not able to solve the problem, e-mail the following log files
to your regional Metrohm representative.

￭ Diagnostics log: C:\Agilent\ICPMH\LOG\MetrohmIC
￭ Log files for the Agilent ICP-MS: C:\Agilent\ICPMH\LOG

Configuration

Reset configuration

If you change the physical instrument configuration, in some cases you
cannot adapt the instrument configuration in Metrohm IC Driver, ICP-MS
MassHunter accordingly. Therefore, reset the configuration.
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Example: A 940 Professional IC Vario and a 942 Extension Module Vario
are configured and physically connected. If you disconnect the 942 Exten-
sion Module Vario, it is still present in the configuration and cannot be
removed.

 

1 Open the following folder:
C:\ProgramData\Metrohm\MassHunter

 

2 Remove the file AutoConfigSettingsList.xml.

 

3 Open the application Instrument Configuration (Windows start
menu ▶ Metrohm ▶ Instrument Configuration).

The configuration is empty.

 

4 Configure the connected modules with Select Instruments ▶ Scan
(see chapter 3, page 3).

The instrument connection in Metrohm IC Driver, ICP-MS MassHunter
matches the physical configuration.

A new file AutoConfigSettingsList.xml is created with the new
configuration.
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